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Sadržaj predmeta

• Definicija projekta
• Životni ciklus projekta – stadijumi projekta
• Generisanje i selekcija projektne ideje – neekonomksa analiza
• Iniciranje projekta – Business Case (Poslovni slučaj)
• Planiranje projekta – Studija izvodljivosti – uključujući vrednovanje i 

evaluaciju projekata zasnovanu na finansijskim parametrima
• Planiranje projekata - Planiranje organizacione strukture
• Planiranje projekta – Primena MS Project softver



MS Project tutorial

• Ukoliko ste odgovorni za koordinaciju velikog broja specifičnih aktivnosti
koje se moraju završiti u toku određenog vremenskog okvira i sa
ograničenom količinom resursa, vi ste projekt menadžer, i onda je ova
lekcija namenjen upravo vama.

• Razvoj novog softvera, izdavanje časopisa, izvođenje programa obuke,
započinjanje novog biznisa pa čak i izgradnja kuće su neki od
projektata sa kojima se milioni ljudi susreću svakog dana.

• Kako vam Microsoft Project pomaže u radu? Pomaže vam u sastavljanju plana
akcije, popunjavanju i organizaciji svih detalja koji se moraju okončati u cilju
postizanja ciljeva. 

• Od nivoa planiranja novog projekta do priprema izveštaja o projektu, praćunju
progresa, analize troškova, procene kvaliteta i upravljanja višestrukim projektima, 
Microsoft Project obavlja sve navedene funkcije. 



MS Project tutorial

• Microsoft Project je zasnovan na Office software modelu i novija je
nadgradnja ovog programskog paketa. 

• Pre nego počnemo sa prvom lekcijom, podsetimo se nekoliko osnovnih
termina i definicija koje će biti često korišćene:

• Aktivnosti (Tasks) Predstavljeju podelu celokupnog posla koji je potrebno
obaviti kako bi se postigli ciljevi projekta.

• Obim (Scope) Predstavlja kombinaciju svih pojedinačnih aktivnosti i
njihovih ciljeva.

• Resursi (Resources) mogu biti ljudi, oprema, materijal i usluge koji su
potrebni za obavljenje različitih aktivnosti. Količina resursa utiče na obim i
vreme trajanja svakog projekta. 



MS Project tutorial

• MS Project komunicira sa vama preko svojih interfejsa: grafički i radni
listovi, meniji, toolbar-ovi i dijalog box-ovi.

• Toolbar-ovi omogućuju prečice do često korišćenih funkcija. 
Pre nego se upustite u projekat morate sebi definisati nekoliko ključnih tačaka:

1 konceptirati i identifikovati svrhu projekta
2. definisati ciljeve projekta
3. finalizirati obim projekta
4. identifikovati sve aktivnosti
5. dodeliti resurse aktivnostima
6. uraditi polaznu procenu (predviđanje) potrebnog vremena i troškova
7. učiniti pažljive procene o različitim releventnim faktorima koji mogu

uticati na trajanje projekta i njegove troškove
8. razmotriti alternatine scenarije i napraviti kontigencijske planove

MS Project vam ne može pomoći kod tačaka (1), (2), (7) i (8) ali kod ostalih operacija može
biti od velike koristi i na taj način vas lagano dovesti do željenih ciljeva.



MS Project tutorial

• MS Project Tutorial Lekcija 1
Tasks (aktivnosti)
a. Otpočeti novi projekat (otvaranje novog MS Project fajla)
b. Snimanje osobina
c. Pogledi (Views)
d. Unos aktivnosti i određivanje dužine trajanja aktivnosti
e. Opis aktivnosti
Linkovi (Links) Veze
a. Povezivanje aktivnosti prema F-S zavisnosti
b. Odložene i preklopljene veze
Ograničenja (constrains)
a. Primena ograničenja
b. Uklanjanje ograničenja i primena ASAP/ALAP ograničenja
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• Otvaranje novog MS Project fajla:
• Otvaranje novog projekt fajla možete ostvariti korišćenjem komandi:

File→New. U dijalog box-u New File koji se otvorio, odaberite Project
Templates tab i odaberite projektni šablon koji vam najviše odgovara i
nakon toga OK. (Možete odabrati i Blank Project šablon i sami ga
prilagoditi), što ćemo u ovoj vežbi i učiniti.

• Sada, pomoću Menija Project Information, na tabu Project, MS Projectu možete
definisati polazni ili krajnji datum vašeg projekta.

• Ukoliko krećete od startnog datuma, MS Project raspoređuje sve aktivnosti
od tog datuma, zasnovano na redosledu po kome aktivnosti trebaju da se
obave i raspoloživosti resursa određenih za rad na svakoj aktivnosti. Ali,
ukoliko morate da završite projekat do određenog datuma, možete uneti
krajnji datum. Svi međurasporedi biće definisani MS Projectom. 
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• Pogledi (Views)
Pogledi vam omogućuju da svoj projekat sagledate iz različitih uglova
zasnovano na tome koju informaciju želite da dobijete u određenom
momentu vremena. Vrsta pogleda se može pronaći na tabu Task →View

• Pogledi na projekat su kategorizovani u dva osnovna tipa:
- Task Views (Pogledi na aktivnosti) kojih ima 5 tipa
- Resource Views (Pogledi na resurse) ima ih 3 tipa

• Radni list projekta je lociran u centralnom delu aplikacijskog prozora i pruža
različite informacije zavisno od izabranog pogleda. Osnovni pogled (default
view) je Gantt Chart View, odnosno Gantt-ogram . 

* Henry Gantt je koristio grafikone za histogramski prikaz u svojim studijama industrijskog menadžmenta u cilju
poređenja vremenskih okvira i planova. U MS Projektu, njegovi grafikoni su u kombinaciji sa radnim listom
(spreadsheet-om) i zajedno daju Gantt Chart View .
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• Sledeći korak predstavlja stvaranje okvira poslova koji se moraju obaviti na
projektu. Ciljevi svakog projekta moraju biti definisani u vidu radnih
aktivnosti.

• Postoje četiri osnovna tipa aktivnosti (Tasks):
• Summary tasks (Sumarne aktivnosti) - sadrže podaktivnosti i njihove osnovne

osobine
• Subtasks (Podaktivnosti)- su manje aktivnosti koje su delovi Summary task-a
• Recurring tasks (Periodične aktivnosti) – su radne aktivnosti koje se javljaju u 

redovnim intervalima vremena
• Milestones (prekretnice) su aktivnosti koje imaju nulto trajanje i mogu se definisati

kao privremeni ciljevi projekta. 



MS Project tutorial

• Kliknite u prvu ćeliju i unesite naziv aktivnosti. Pritisnite Enter da bi 
ste prešli u sledeći red. 

• Po default-u, pretpostavljeno trajanje svake aktivnosti je jedan dan.
Ali, samo je mali broj aktivnosti koje se mogu završiti za jedan dan.

• Možete uneti trajanje aktivnosti tek pošto donesete odluku na osnovu
odgovarajuće procene. 
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• Unos aktivnosti i određivanje dužine trajanja aktivnosti
•
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• Dvostruko kliktanje na aktivnost ili pokretanje opcije Task → Information sa
toolbara, pokreće tekst box Task Information. 

• Tu se mogu uneti detalniji opisi svake radne aktivnosti kao i opisati planovi
u vidu beleški i komentara.

• Da bi se uneo milestone, unesite ime radne aktivnosti i podesite mu 
trajanje na nulu. Drugi način je pomoću menija Insert → Milestone, u Tab-
u Task. MS Projekt milestone (ključni događaj) označava romboidom, 
umeso plavim pravougaonikom na Gantt Chart-u.

• Da bi ste kopirali aktivnosti, ili njihov sadržaj, kliknite na ID broj aktivnosti
(broj sa leve strane naziva aktivnosti u radnom listu ) i upotrebite opciju
copy i paste kao i kod bilo kog drugog Windows software-a. 
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• Hijerarhija aktivnosti
• Sumarnu akivnost (summary task) možete uneti pomoću opcije Insert 

→ Summary. Ili tako što ćete je uneti običnu aktivnost i potom 
aktivnosti koje slede nakon nje, a koje će biti deo te sumarne 
aktivnosti (podaktivnosti – subtasks), uvući pomoću opcije Schedule 
→ Indent Task.

• Svaka akcija koju radite na sumarnoj aktivnosti-brisanje, pomeranje ili
kopiranje odnosi se i na njene podaktivnosti.



Indent Task
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• Unos periodične aktivnosti vrši se pomoću opcije na meniju Insert →
Task → Recurring task.
Potrebno je uneti dužinu aktivnosti kao i način periodičnog
pojavljivanja.



MS Project tutorial
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• POVEZIVANJE (LINK)
• Polazne aktivnosti se obično planiraju sa početkom što je ranije moguće, odnosno

prvi radni dan nakon datuma startovanja projekta.
• Preostali raspored može se definisati putem osnovnog kalendara sa kojim je MS 

Project povezan. MS Projekt sadrži tri kalendara i bilo koji od njih može biti
upotrebljen: Standardni kalendar, 24-tvoro časovni kalendar i kalendar noćne
smene. Kalendari se mogu izabrati za celopkupni projekt (preko Project → 
Information), kao i za pojedinačne aktivnosti (Task → Information → Advanced)

• Ovi kalendari raspoređuju zadatke sa različitim radnim danima i satima. 
• Kao osnovni kalendar se najčešće koristi standardni kalendar.
• Dužina bilo koje aktivnosti može se videti kao plavi pravougaonik različite

dužine na Gantt-ovom dijagramu u delu vremenske linije. 
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• Ponekad, čak i nakon završetka rasporeda mnoge nepredviđene promene
mogu uticati na završetak aktivnosti. Ovo može dovesti do poremećaja
završetka drugih aktivnosti vezanih za ovu. 

• Da bi se rešio ovaj prolem MS Projekt vam omogućava da povežete
(linkujete) aktivnosti na različite načine. 

• Povezivanjem aktivnosti MS Projekt podešava raspored sa svakom
promenom koja utiče na dužinu ostalih aktivnosti.

• Aktivnost koja mora da se završi ranije (krečenje zidova mora da se završi
pre unošenja nameštaja) se naziva prethodna (predecessor) a povezana
aktivnost se naziva naredna (sucessor).
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• Aktivnosti mogu biti povezane na sledeće načine: 



MS Project tutorial
• Povezivanje aktivnosti prema FS zavisnosti
• 1. Odaberite aktivnosti koje želite da povežete. Aktivnosti sa nižim ID brojem automatski se 

posmatraju kao prethodne.
• Ukoliko sami želite da zadate raspored aktivnosti to možete učiniti tako što ćete koristiti opciju 

Manually Schedule, za selektovanu aktivnost.
• Na taj način, ukoliko želite da npr aktivnost 1.1 prethodi aktivnosti 1.2. , dva puta kliknuti na 

aktivnost 1.2 i iz taba Predecessors, iz padajućeg menija potražiti aktivnost 1.1. Osnovni tip veze je 
FS.

• Sumarne aktivnosti ne mogu biti linkovane za svoje podaktivnosti ali mogu za druge sumarne
aktivnosti ili za podaktivnosti druge sumarne aktivnosti.

• Podaktivnosti mogu biti linkovane međusobno.
• Da bi ste razvojili aktivnosti (unlink), selektujte ih i upotrebite taster Unlink Task sa Tool bar-a

Schedule. 
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• Odložene i preklopljene veze
• Ponekad aktivnosti mogu biti zavisne od drugih faktora koji izazivaju kašnjenje ili

preklapanje aktivnosti, tada je neophodno uneti vreme zastoja ili prednjačenja aktivnosti
u okviru link-a. 

• Vreme zastoja ili prednjačenja se može uneti u vremenskim jedinicama ili kao procenat
trajanja prethodne aktivnosti.

1. Dva puta kliknite na aktivnost čime otvarate Task Information dialogbox.
2. Kliknite na tab Predecessor
3. Selektujte polje lag
4. Unesite broj vremenskih jedinica (ili procenat) u ćeliju. Broj može biti pozitivan ili

negativan, zavisno da li se radi o kašnjenju ili prednjačenju.
5. Kliknite OK.

• Taster za podelu aktivnosti (Split task button) deli aktivnosti koji se mogu odvijati u 
delovima za različite intervale vremena. 



MS Project tutorial

• OGRANIČENJA
Pojedine aktivnosti moraju biti završene do određenog datuma. Ponekad je
potrebno uneti među-datume. 

• Zadavanjem ograničenja aktivnostima mogu se rešavati problemi
raspoređivanja. 

• Postoji 8 tipova ograničenja i svrstani su u fleksibilnu ili nefleksibilnu
kategoriju.
a. Primena ograničenja
1. Otvoriti Task information dialog box
2. Kliknuti na tab Advanced i otvoriti Constraint type listu pomoću
padajućeg menija.
3. Izabrati vrstu ograničenja i kliknuti OK. 

Napomena: da bi se moglo koristiti ograničenje, aktivnost mora da bude sa opcijim Auto Schedule a ne 
Manual Schedule, u Tab-u  Task → Tasks



MS Project tutorial

• MS Project Tutorial Lekcija 2 (Resursi)
U ovoj lekciji naučićemo da uspešno raspoređujemo resurse potrebne za
uspešan završetak projekta-ljude, opremu, zalihe i materijal. Takođe ćemo
naučiti da objedinimo troškove različite vrste i povezivanje resursa za
zadatke.
Ova lekcija se sastoji od tri osnovna dela:
1. Resursi (Resources)
a. Unos informacija o resursima
b. Liste resursa
c. Dijalog box Informacije o resursima
d. Vezivanje osnovnog kalendara za resurse
e. Editovanje kalendara resursa



MS Project tutorial

• 2. Dodeljivanje (Assignments)
a. Dodeljivanje resursa aktivnosti
b. Tipovi aktivnosti
c. Promena osnovnog tipa aktivnosti
d. Dodeljivanje resursa rada aktivnostima (radnih resursa)
e. Dodeljivanje resursa rada u formu aktivnosti
f. Dodeljivanje materijalnih resursa aktivnostima
g. Dodeljivanje materijalnih resursa aktivnostima u Gantt-ovom dijagramu

• 3. Troškovi (Costs)
a. Definisanje i kontrola troškova
b. Metode priraštaja (kumulativne metode) = accrual methods
c. Unos informacije o troškovima
d. Unos troškova resursa



MS Project tutorial

• RESURSI
Kada ustanovite da je potrebno uključiti resurse u vaš projekat
potrebno je da odgovorite na sledeća pitanja:
- kakvi su mi resursi potrebni ?
- koliko mi je potrebno svakog resursa ?
- gde mogu da nabavim resurse ?
- na koji način ćete odrediti koliko će vaš projekat koštati ?

• Resursi se mogu svrstati u dve osnovne grupe-resursi rada (radni
resursi) i materijalni resursi. 



MS Project tutorial

• Resursi rada obavljaju zadatke uz trošenje vremena. Oni su obično ljudi i
oprema kojoj je dodeljeno da radi na projektu.

• Materijalni resursi su nabavke i zalihe potrebne za završavanje projekta.
Kada je određena količina resursa dostupna za rad one se mogu nazvati
zalihom resursa. 

• Nakon što odredite kvantitet potrebnih resursa, potrebno je utvrditi vreme
i dostupnost svakog resursa. 

• U slučaju resursa rada, mora biti poznat iznos vremena koje oni mogu da 
rade u satima, danima ili mesecima.

• Kada se radi o materijalnim resursima potrebno je definisati potrebne
količine u jedinicama mere. 
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• Sledeći korak se sastoji u povezivanju ovih resursa sa njihovim
aktivnostima. 

• Kada se alociraju resursi za zadatke MS Project može da rekalkuliše
raspered da bi prilagodio radno vreme dodeljenih resursa.

• Za svaki resurs mogu se identifikovati odmori i neradni dani. 
• MS Project ide i jedan korak ispred i govori vam kada ste za radni

zadatak alocirali višak resursa, odnosno kada ste dodelili resurse
višestrukim aktivnostima u istom periodu vremena ili kada je resursu
dodeljeno da obavlja više posla nego što može da završi u određenom
vremenu. 
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• UNOS INFORMACIJE O RESURSIMA U PROJEKAT:
Dijalog box za dodeljivanje resursa (Assign Resources), nalazi se na 
Tab-u Resource i koristi se za stvaranje listi resursa koji su neophodni
za obavljanje posla na projektu. 
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• b. Unos liste resursa
1. Kliknite taster Assign Resources sa Resource Toolbar-a
2. Selektujte ćeliju u koloni Resource Name (Ime resursa) i ukucajte ime odgovornog za
ovu vrestu resursa (odgovarajuće ime). Pritisnite Enter. Karakteristiku resursa možete 
uneti tako što dva puta kliknete na naziv resursa. Otvoriće se prozor Resource 
Information, gde možete borati da li je u pitanju resurs iz kategorije: Work, Material ili 
Cost. Sa Tab-om Change Working Time u okviru ovog box-a, možete dodeliti različite
osnovne kalendare svakom resursu i izmeniti radno vreme ovog resursa kada i koliko je 
potrebno. 
3. Ponovite korak 2 sve dok ne unesete sve odgovarajuće resurse.
4. Dodeljivanje resursa aktivnosima se vrši preko komande assign.

• Imena resursa ne mogu da sadrže oznake kao što su (/), zagrade [] i zareze (,). 
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• Drugi način za definisanje vaše liste resursa je preko Resource Sheet pogleda (koji se nalazi u Tabu 

View):
• 1. Pokrenite Resource Sheet View ikonu na View bar-u.

2. Unesite željene informacije o resursima (Za unos materijalnih resursa upotrebiti polje Material Label)

• Kolona Max Units sadrži maksimalni kapacitet za koji je radni resurs dostupan za završetak bilo
koje aktivnosti u određenom vremenskom periodu. Osnovni format je format procenata, Na 
primer, ukoliko su dodeljene jedinice 100% ovo će značiti da će ovaj resurs raditi svih osam
sati normalnog radnog dana. Ako su dodeljene jedinice 50%, ovaj će resurs raditi četiri sata
dnevno. Ako se grupacija resursa sastoji od 5 radnika, njihov maksimum je 500%.

• Materijalni resursi ne sadrže Max Units. Njihove jedinice resursa pokazuju njihov intenzitet
trošenja koji može biti fiksan ili varijabilan.

• Ostale tri kolone u Resource Sheet View se odnose na troškove i na njih ćemo se vratiti nešto
kasnije. 
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• DODELJIVANJE (ASSIGNMENTS)
a. Dodeljivanje resursa zadatku
1. Otvorite Gantt Chart View i assign Resources dijalog box.
2. U tabeli Gantt Chart View –a, selektujte aktivnosti za koje želite da
vežete resurse.
3. U Assign Resources dijalog box-u, odaberite resurs (resurse) koje
želite da dodelite.
4. Kliknite Assign taster. 

• Drugi način je da se dva puta klikne na aktivnost u Gantt Chart View i da se 
preko taba Resources, iz padajućeg menija dodeli neki od raspoloživih 
resursa.

• Možete promeniti ili dodeliti više resursa aktivnostima ili jedno aktivnosti, 
upotrebom Assign Resources dijalog box-a. 
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• Dodeljivanje materijalnih resursa aktivnostima u Gannt-ovom dijagramu
1. Selektujte aktivnosti iz Gantt-ovog dijagrama.
2. Selektujte polje naziv resursa u okviru task form-e.
3. Iz padajućeg menija odaberite naziv resursa.
4. Odaberite polje jedinica (units) i unesite količinu jedinica koju želite. Ako
ostavite ovo polje prazno MS Projekt će uneti vrednost 1.
5. Nakon svih učinjenih izmena, kliknite OK.

• Ukoliko želite da uklonite dodeljeni resurs sa aktivnosti selektujte aktivnost
i onda ime resursa koji želite da uklonite i upotrebite komandu Delete sa
tastature. 



MS Project tutorial

• TROŠKOVI (COSTS)
a. Definisanje i kontrola troškova:
MS Project množi broj časova rada resursa i časovne troškove da bi se
dobila cena koštanja (trošak) resursa. 

• Za više resursa individualni troškovi resursa se sabiraju. Broj upotrebljenih
jedinica reflektuje se na materijalne troškove.

• Standardni iznos (Standard Rate), odnosno iznos koji treba platiti po jedinici
vremena za uobičajne časove rada ili cena po jedinici materijalnog resursa, kao i
iznos prekovremenog rada definisan za prekovremeni rad (Overtime Rate) su dve
vrednosti iznosa koje treba uneti u Resource Sheet pogledu.

• Fiksni troškovi i troškovi resursa se dodaju ukupnim troškovima. 
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• Unos informacije o troškovima
U tab-u costs u okviru Resources Information dijalog box-a možete
uneti do 5 različitih iznosa za selektovani resurs koji je dodeljen na 5 
različitih zadataka (tabovi A-E). Ovaj dijalog box se otvara tako što se u 
okviru Task Form dijalog box-a, selektuje resurs i dva puta klikne na
njega.
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• Unos troškova resursa:
1. Otvorite Resource Information dijalog box i u okviru njega tab costs
2. Unesite standardni iznos. Za radne resurse osnovna je dinica je din/h.
Materijalni resursi koriste jedinicu resursa koja im je dodeljena (kom, litar
(l), kg,...).
3. Unesite iznos za prekovremeni rad (unesite je čak iako je isti kao i
standardni rad).
4. Unesite i dodatne troškove za upotrebi resursa (troškovi koje fiksno treba 
platiti – bez obzira na radne sate i/ili troškove transporta
itd.) 

• Ukoliko resursi imaju drugačiji metod kumulativnog proračuna,
izaberite ga sa Cost Accrual padajućeg menija
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• MS Project Tutorial Lekcija 3
Pošto smo videli način na koji se resursi dodeljuju aktivnostima i
troškovi resursima, pogledajmo način za rukovanje okvirima i
prekomernim resursima. 

• Takođe ćemo naučiti kako da fino podešavamo projekat i pripremimo
ga za publikaciju.

1. Okvir
2. Prekomerni resursi
3. Fino podešavanje i priprema projekta za publikaciju. 
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• OKVIR (CONTOURS)
Resursi su obično ljudska bića i iz tog razloga unose dosta nepredvidljivosti
u projekat: datumi mogu da se promene, resursu može biti dodeljeno
previše posla ili možda moraju da napuste organizaciju u toku projekta. 

• Iz tih razloga potrebno je ostaviti mesta za promene u dodeljivanju i
raspodeli posla.

• MS Project vam omogućuje da uredite da resursi započnu ili završe posao u
određenim datumima, prekinu dodeljene poslove da bi im se omogućilo da
rade na drugim aktivnostima i dodeliti im prekovremeni rad ukoliko je
neophodno - drugim rečima uokviravanje dodeljenog posla je omogućeno.

• Pogledi: The Task Usage View i Resource Usage View nude takve
mogućnosti. 
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• Šta termin okvir znači u projektima? To je oblik raspodele posla u okviru
dodeljenih resursa. Obično, ako je resurs dodeljen 100% aktivnosti koja
traje 40 sati uz nepostojanje prethodnih aktivnosti, zadatak će početi
odmah uz 8 sati rada dnevno u toku 5 dana. 

• Ovo je osnovni ravni radni okvir gde je rad svake jedinice ravnomerno
raspoređen tokom trajanja aktivnosti.

• Ponekad, potrebno je da promenite raspodelu rada dodeljenih resursa
primenom unapred definisanog okvira ili kreiranjem uobičajnog okvira za
određene aktivnosti. 
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• MS Project uključuje 8 predefinisanih okvira koji su navedeni:
• Flat (Ravan): Difolt okvir sa ravnomernom raspodelom posla
• Back-loaded (Krajnje Opterećen): najveće opterećenje dešava se na kraju projekta-

odskočno. 
• Front-loaded (Početno opterećen): najveće opterećenje se dešava na početku projekta-

odskočno.
• Double Peak (duplo opterećen): projekat koji ima dva glavna perioda najvećeg

opterećenja
• Early Peak (rano opterećenje): isto kao Front-loaded ali uz postepeno uvođenje najvećeg

opterećenja (nagib)
• Late Peak (kasno opterećenje): Back-loaded uz postepeno najveće opterećenje (nagib)
• Bell (zvono): jedno opterećenje u sredini projekta-odskočno
• Turtle: zvono sa laganim usponom i spustom (uz nagib) 



MS Project tutorial

• Da bi se promenio radni okvir dodeljenom resursu u Task Usage pogledu
ili u Resource Usage pogledu, dva puta kliknite na dodeljeni resurs da bi se
otvorio Assignment Information dijalog box i odaberite okvir iz Work
Contour padajućeg menija.

• Ova opcija je moguća samo ako smo se opredelili da se aktivnost raspoređuje po 
principu Auto Schedule a ne Manually Schedule.

• Okviri utiču na aktivnosti i podešavanje resursa prema vašem upravljanju i
prilagođavaju dodeljene resurse tokom životnog ciklusa projekta. 

• Oblik okvira je vezan za dodeljeni resurs čak i ako pomerite aktivnost ili kada se
promeni projektni raspored.

• Kada ručno menjate dodeljene resurse u okviru Resource Usage pogleda ili
Task Usage pogleda, rezultat je izmenjeni okvir. Sa svakom promenom okvira, MS 
Project raspodeljuje trajanje projekta i preračunava jedinice troškova. 
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• VIŠAK DODELJENIH RESURSA (OVERALLOCATED RESOURCES)
Resursi su previše dodeljeni kada je suma njihovog faznog rada (rada
podeljenog tokom specifičnih perioda projekta) prevazilazi
maksimalne jedinice resursa. 

• Ukoliko je resurs već raspoređen da radi na različitim aktivnostima, 
resurs može postati previše dodeljen.

• U okviru resource usage pogleda ovakvi resursi su obojeni crveno. 
• U Resource Sheet pogledu, pored ovakvih resursa stoji znak uzvika. 
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• Lociranje viška dodeljenih resursa
Kombinujte Resource Graph sa Resource Form-om da bi ste videli dodeljene resurse i
informaciju o resursima uz raspored resursa. Desni klik na grafik otvara meni sa
prečicama (shortcut menu).
Način rešavanja viška dodeljenih resursa
Moguće je:
- odložiti aktivnost
- podeliti aktivnost
- dodeliti druge resurse
Desni klik na grafik otvara meni sa prečicama (shortcut menu). Da bi ste proverili
preostalu dostupnost resursa odaberite Remaining Availability opciju.
MS Project nudi opciju ujednačavanja koja može podesiti dodeljene resurse deljenjem ili
odlaganjem aktivnosti. Koristi faktore kao što su:
- Dostupno vreme
- Prioritet aktivnosti, zavisnosti i ograničenja
- ID aktivnosti
- Datume u rasporedu
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• Primena opcije ujednačavanja:
1. Selektujte bilo koju aktivnost
2. Odaberite tab Resource→Level Resource. Ovo otvara Level Resource
dijalog box.
3. Selektujte resurs koji je preopterećen, odaberite Level. Nakon što
identifikuje višak dodeljenih resursa, MS Project raspoređuje aktivnosti
prema adekvatnom nivou ujednačavanja. 

• Aktivnosti sa ograničenjima tipa Mora se završiti do (Must Finish On), što
pre je moguće (As Soon as Possible) ili što je kasnije moguće (As Late as
Possible) se ne ujednačavaju, kao ni aktivnosti koje su već otpočele. 
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• FINO PODEŠAVANJE I PRIPREMA PROJEKTA ZA PUBLIKOVANJE IZVEŠTAJA
• Do sada smo se bavili aktivnostima, resursima, dodeljivanjem resursa i

troškovima. 
• Dizajn vašeg projekta je gotovo kompletan, ujednačen i spreman za

prezentaciju i nakon odobrenja može se krenuti u implementaciju.
• Pre nego što napravite prezentaciju korisno je da izvršite pregled

dosadašnjeg rada.
• Za fokusiranje ukupnog kvaliteta i usaglašenosti projekta, MS Project koristi

veći broj alata.
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• Moguće je:
• Prikazati sumu celokupne statistike upotrebom displeja Summary tabele
• Upotreba filtera na informaciji koju želite da vidIte
• Sortiranje i grupisanje informacija
• Identifikovanje i primena strategija za smenjenje trajanja i troškova
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• Dijalog box Project Statistics daje sumarne informacije o vašem
projektu.

• Ovaj dijalog box se pokreće preko: Tab Project→Project
Informa on→Sta s cs.

• U okviru ovog dijalog box-a vidite datum starta i finish-a vašeg
projekta. 

• Trajanje projekta, kao i troškove, MS project prikazuje u okviru 
dodatne tabele u ovom dijalog box-u.
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• Promena Vremenske skale
Osnovna (default) vremenska skala u pogledu Gantt-ovog Dijagrama su
nedelje i dani. Ako želite širu sliku projekta, možete zumirati vremensku
skalu na mesece i nedelje. Kliknite na Tab View i tu u okviru menija ZOOM –
Timescale, možete odabrati željenje vremenske jedinice. 

• Printanje Izveštaja
Uz MS Project možete printati izveštaje o svakom aspektu vašeg projekta.

• Odaberite TAB Reports da bi ste otvorili Report dijalog box-ove i kliknite na
tip izveštaja koji želite da generišete ili printate


